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WinTR-55 for Plan 
Reviewers

Small Watershed Hydrology
Modeling Single Sub-area Watersheds

(Part 1)
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Modeling Single Sub-Area Watersheds

Course Outline

• Overview
• Review of Hydrology Terms 
• Modeling Single Sub-area Watersheds
• Modeling Single Sub-area Watersheds
• Multiple Sub-area Watersheds
• Modeling Structures
• Advanced Features of WinTR-55

We’re now going to look at modeling single sub-area watersheds with WinTR-55. This 
lesson will covers the majority of the features of WinTR-55 and this level of training is 
beneficial to all users.
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Modeling Single Sub-Area Watersheds

Lesson Objectives

Upon completion of this lesson, you will be able to:
• Start the WinTR-55 program and navigate through 

the various windows
• Develop input data for single sub-area watersheds
• Input sub-area data into WinTR-55
• Run WinTR-55
• Interpret Output

The objectives for this lesson are for you to be able to:

Start WinTR-55 and navigate through the various windows;

Develop input data for single sub-area watersheds and understand what the minimum 
data requirements are to complete a run;

Input the data into the program;

Run the program; and

Interpret the output.
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Starting WinTR-55
and

Program Windows

We’ll begin by looking at starting the program, then take a look at the WinTR-55 Main 
Window. Then we’ll look at various other data input windows, and discuss the data 
input parameters along with some items to watch out for when developing input data 
for and running WinTR-55. Click along to start the program and navigate to the 
various windows as we discuss them.

(Note to Instructor: At this point, all students should have their computers ON and be 
starting the program and navigating to each of the various windows as they are 
discussed.)
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Modeling Single Sub-Area Watersheds

Starting the Program
From Windows Explorer: OR

Desktop 
Shortcut:

The standard method of starting the program is to click the Start button located at the 
bottom left hand of the computer monitor, then navigate to Programs, then to
Engineering Applications, and finally to WinTR-55.

Of course, if you have a WinTR-55 shortcut located on your desktop, it is 
necessary only to click on the WinTR-55 icon to start the program. A desktop shortcut 
is NOT created as part of the WinTR-55 installation. You will have to create your own 
desktop shortcut if you want one.

Start the program now if you haven’t already done so.



5/11/2007

6

Modeling Single Sub-Area Watersheds

Welcome to WinTR-55

On first start up, the Welcome to WinTR-55 window opens. Here you will find:

the Disclaimer, stating that you, as the user, hold ultimate responsibility for 
interpretation of any data generated through using this program;

a Start button which will take you to the WinTR-55 Main Window;

a New User? button which will open Help for Welcome to WinTR-55 window titled 
Help for a New User;

an Exit Program button which allows you to exit the program without doing 
anything else; and

a Check here to skip this introduction in the future box. If you check this box, the 
Welcome to WinTR-55 window will not show the next time you open WinTR-55. Instead, 
the program will open at the WinTR-55 Main Window.
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Modeling Single Sub-Area Watersheds

Help for Welcome to WinTR-55

Clicking the New User? button from the Welcome to WinTR-55 window, a opens the Help 
for Welcome to WinTR-55. 

Each WinTR-55 window has a help window associated with it, either through a menu 
item or a help button, depending upon which window you are working in. This is 
useful to know since no matter where you are in the program you can easily access 
help for that particular window.

A link to the WinTR-55 User Guide is listed on all the Help windows. This is a hot-link 
and should open the WinTR-55 User Guide which is included with the WinTR-55 
installation package.
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Modeling Single Sub-Area Watersheds

WinTR-55 Main Window

•Menu Bar

•Buttons Bar

•Input Boxes

Clicking the Start button from the welcome window opens the WinTR-55 Main Window.

The WinTR-55 Main Window looks pretty much like most computer programs written 
for the Windows operating system.

Features of this window are:

the Menu Bar through which all options and features of the program are 
accessible;

the Button Bar which allows you to open new windows or perform other activities 
without having to search through the menu bar for the appropriate options; and

Data Input Boxes where you enter data by typing it in.

Let’s take a bit more of an in-depth look at these features.
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Modeling Single Sub-Area Watersheds

File Menu
• New

• Open or          button

• Save/SaveAs or
button

• Page Setup

• Exit

• List of recent files

The File menu looks like that of any windows operating system program. The menu 
choices here are

New (to clear out any data and start a complete new file), *click* Open or the Open 
button (to open an existing file),

Save (to save a data file) or Save as (to rename a data file to another name) or the 
Save File button,

Page Setup (to format output printouts), and

Exit (to exit the program).

There is also a list of recently accessed files to provide quick access to those 
files.
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Modeling Single Sub-Area Watersheds

Options Menu

Note:  If you switch units back and forth, accuracy will be lostNote:  If you switch units back and forth, accuracy will be lost !!

•Units
English
Metric

•Clear Recent Files

(Update screen captures.)

The Options menu allows you to specify the measurement system in which you are 
working.

Both English Units and SI Units are available. One note of caution: All 
computations are done in English units. If you specify SI units, the program converts 
those to English units, performs the computations and converts the reported results 
back to SI units. So, if you switch units continually back and forth from English to SI 
Units, accuracy will be lost.

Clear Recent Files clears the list of recently opened files at the bottom of the File 
menu.
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Modeling Single Sub-Area Watersheds

ProjectData Menu
• Land Use Details

or          button 

• Time of Concentration
Details or          button

• Structure Data
or          button

• Reach Data or
button

• Reach Flow Path
or          button

To navigate to the ProjectData menu input windows you can use either the drop-down 
menu from the menu bar or use the appropriate buttons from the button bar.

Land Use Details takes you to the window allowing you to compute runoff curve 
numbers.

Time of Concentration Details takes you to the window allowing you to compute 
times of concentration.

Structure Data takes you to the window allowing you to enter data for a structure.

Reach Data takes you to the window allowing you to enter data for stream 
reaches.

Reach Flow Path opens a window showing a simple line drawing schematic of the 
watershed you are trying to model.
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Modeling Single Sub-Area Watersheds

GlobalData Menu
• Storm Data or        

button

• Custom Rainfall
Distributions or

button

• Dimensionless Unit
Hydrograph or
button

Through the GlobalData menu items or associated buttons, you can access the 
following windows and features: 

Storm Data which allows you to view and edit the rainfall data used for your 
particular WinTR-55 evaluation.

Custom Rainfall Distributions which allows you to enter a custom rainfall 
distribution if you must deviate from the standard distributions built in to WinTR-55.

Dimensionless Unit Hydrograph which allows you to enter a custom dimensionless 
unit hydrograph if you need to utilize this feature.

We’ll look at each of these items in further detail shortly, but for now, this is how 
those windows are accessed from the Main Window.
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Modeling Single Sub-Area Watersheds

Run Menu

• Run from menu bar 
or          button

• Run WinTR-55
window

• Check storm(s) to 
evaluate

• Click           button

Until you have entered sufficient data to execute a run, the Run Menu option and Run 
button will remain grayed out.

Once sufficient data has been entered, these items will go live and clicking Run 
from the menu bar or the Run button opens the Run WinTR-55 window.

On the Run WinTR-55 window you specify for which storm events you wish to 
execute runs.

Clicking the Run button will cause the program to execute a run.

You’ll see this slide again just a bit later when we talk about actually running the 
program.
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Modeling Single Sub-Area Watersheds

Help Menu

• Show WinTR-55 
Welcome

• Help for WinTR-55 
Main Window  F1

• About WinTR-55

• System Information

Help for WinTR-55 is available through a variety of sources for each window. From 
the Main WinTR-55 Window the Help menu offers access to:

the Show WinTR-55 Welcome Window;

Help for WinTR-55 Main Window (also accessible by pressing the F1 key);

the About WinTR-55 Window; and

the System Information Window.
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Modeling Single Sub-Area Watersheds

Show WinTR-55 Welcome

If you click on Show WinTR-55 Welcome from the Help menu, the WinTR-55 Welcome 
window, that you saw earlier, opens. However, this time there is no Exit button
available and the Start button is replaced with the Resume WinTR-55 button.

You MUST click on the Resume WinTR-55 button to continue.
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Modeling Single Sub-Area Watersheds

Help for WinTR-55

Every HELP window contains a link to the WinTREvery HELP window contains a link to the WinTR--55 User Guide.55 User Guide.

Clicking on Help for WinTR-55 Main Window or F1 opens the Help for WinTR-55 window.

Again, help for each of the WinTR-55 windows is accessible either through a Help 
menu item or a Help button, depending upon the window you are using.

You have the option of printing the help information using the File menu item on 
the Help window.

You may also change the appearance of the Help window by changing Fonts. 

Finally, help for any other window is available by clicking the Help for.. menu item 
and selecting from the drop down menu. 

The WinTR-55 User Guide is also accessible from the Help for.. menu item and a link to 
the User Guide is provided within the Help window text.



5/11/2007

17

Modeling Single Sub-Area Watersheds

About WinTR-55

Clicking on About WinTR-55 from the Help menu opens the About WinTR-55 Small 
Watershed Hydrology window.

This window contains information about the version of WinTR-55 installed on 
your computer.

You will also see the disclaimer statement repeated here.

Also included here is a hot-link e-mail address to the WinTR-55 development team
should you need to e-mail them with any questions.

You MUST click the Close button to close this window and return to the WinTR-55 
Main Window.
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Modeling Single Sub-Area Watersheds

System Information

Clicking System Information from the Help menu opens the System Information window. 
System information is technical information about your computer and is primarily 
information computer programmer’s might be interested in.

That’s is for the menu items, so now a quick review of the buttons and we’ll start 
looking at data inputs.
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Modeling Single Sub-Area Watersheds

WinTR-55 Main Window Buttons
Open

Save

Input Data 
Printout

Land Use 
Details

Time of 
Concentration 
Details

Structure Data

Reach Data

Reach Flow 
Path

Storm Data

Custom 
Rainfall 
Distribution

Dimensionless 
Unit Hydrograph

Run WinTR-55

Summary 
Reports

Output 
Hydrographs

Quick Help

This slide shows a summary listing of all the Buttons from the button bar and the 
windows to which they link.
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Modeling Single Sub-Area Watersheds

Project Identification Data

•User ID

•Project

•Subtitle

•State

•County

•Execution Date

Now that we’ve looked at the menu bar and button bar, let’s look at the data input 
boxes!

Under the Project Identification Data portion of the WinTR-55 Main Window, you enter 
general information about the project. 

First of all, a User id. Something to identify yourself as the person who performed 
the analysis. Typically people enter their initials.

Secondly, a Project name. Something to identify the project.

You may also enter a Subtitle to further identify the project.

Finally, you must specify the location of the project, in this case, State and County.

The last piece of information under the Project Identification Data is the Execution 
Date. The execution date is generated automatically by the program. For new runs, it 
will be the current date. If you open an existing file, however, the date shown will be 
the last date on which that data set was saved. If you run that data, the date will be 
changed to the current date.
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Watersheds Outside the U.S.

State and County
change to          

Region and Locale

For watersheds outside the United States, you need only to type in the name of the 
country and locale. 

As you can see, in this example, the user is making an analysis of a watershed in 
Durango, Mexico. 

As soon as you enter something other than the name of a state from the drop down 
list, State changes to Region and County changes to Locale.

NRCS supplies no rainfall data other than those in the built-in data base, so you are 
responsible for supplying the necessary rainfall data and rainfall distributions for 
areas outside of the United States.
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Modeling Single Sub-Area Watersheds

Project Identification Data

• Sub-areas expressed in:
– Acres
– Square Miles

• Dimensionless Unit 
Hydrograph

• Storm Data Source

• Rainfall Distribution 
Identifier

As you continue entering the Project Identification Data, you will select in which units 
area is specified. Sub-areas are expressed in either acres or square miles if working in 
English units, or hectares or square kilometers if working in SI (metric) units.

You might select a Dimensionless Unit Hydrograph from the drop down list to utilize 
one of the built-in unit hydrographs. However, the default setting is the <standard>
dimensionless unit hydrograph and unless you have a documented reason for using 
something other than standard, you should use the standard dimensionless unit 
hydrograph.

This section of the window also lists the selected Storm Data Source and

Rainfall Distribution Identifier that will be used for this particular run.

It is very important that the Storm Data Source and Rainfall Distribution Identifier listed 
here are appropriate data for the analysis being made. You MUST check this 
information to be certain it is correct. A very simple check is to look and see that the 
State and County listed are the same as the Storm Data Source.
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Modeling Single Sub-Area Watersheds

Project Identification Data

As illustrated on this screen capture, the State and County specified are Franklin 
County, Missouri while the 

Storm Data Source shown is for Howard County, Maryland. In this case, even 
though the user specified Franklin County, Missouri the rainfall data WinTR-55 would 
actually use in executing a run is that for Howard County, Maryland.

A very simple check for you to make certain the proper information is used, is to 
make sure these two items are the same. In this case, they need to both read Franklin 
County, Missouri.

To make the proper change, you need to go to the Storm Data Window.
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Modeling Single Sub-Area Watersheds

Storm Data Window

• GlobalData – Storm 
Data from main 
window menu bar or 

button

To access the Storm Data Window, click Global Data menu item and select Storm Data
from the dropdown menu on the main window, or click the Storm Data button from the 
menu bar on the main window.

For the example we’ve been discussing, we read here that the Storm Data listed is 
for Howard County, Maryland.

Reading the text tells us “To replace these storm data with those compiled by the 
NRCS for Franklin County, MO, click on the command button below.”

So, to make the change for Franklin County, Missouri simply click on the NRCS 
Storm Data button.
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Modeling Single Sub-Area Watersheds

Storm Data Window

After clicking the NRCS Storm Data button we now see that the data listed are for Franklin 
County, Missouri. Double check that by reading the “To replace..” paragraph and observe that it 
also reads Franklin County, MO.

There is a built in Storm Data database that includes 24-hour Rainfall Amount by Rainfall 
Return Period for almost every county in the United States. Each state was asked to submit 
data for the database, but some chose not to submit data because of large variations of rainfall 
across small areas. If you are in one of those locations (primarily in the western states), you 
will need to develop and enter your own rainfall data. You do have the option of doing some 
limited editing of the data, however any editing you might do is NOT saved in the program 
database. You can save the data with your current project file and keep recalling that project 
file when you need to access that rainfall data, but you cannot make changes to the built-in 
database.

An associated Rainfall Distribution Type has also been included into the database. There are 
several standard rainfall distributions built-in to WinTR-55, but occasionally it is necessary to 
deviate and use something else. If you need to utilize a different rainfall distribution, 
development of custom distributions is covered in Advanced WinTR-55 Training. However, 
unless you have a documented reason for utilizing some other rainfall distribution, you should 
use whichever distribution is specified for the area in which you are working. 

To accept changes as specified, click the Accept button to return to the WinTR-55 Main 
Window.

Don’t forget to click Accept!  If you don’t, WinTR-55 will NOT register the change and whatever 
the previous data was is the data that will be used!
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Modeling Single Sub-Area Watersheds

Project Identification Data

Upon returning to the main window that the project location (State and County) and 
Storm Data Source are the same, in this instance, Franklin County, Missouri. 
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Modeling Single Sub-Area Watersheds

Sub-area Entry and Summary

• Sub-area Name
• Sub-area 

Description
• Sub-area Flows to 

Reach/Outlet
• Area (ac)
• Weighted CN
• Tc (hr)

In the Sub-area Entry and Summary portion of the main window you will specify: 

a Sub-area Name for each sub-area being analyzed,

a Sub-area Description, and

the location to which the water leaving that sub-area flows in the Sub-area Flows to 
Reach/Outlet column.

You may directly enter the

Area,

Weighted CN (Runoff Curve Number), and

Tc (Time of Concentration) in hours if you already have this information from another 
source. If you plan to use WinTR-55 to compute the runoff curve number and time of 
concentration these columns will be filled as you work through the appropriate windows.

The total Project Area is tallied at the bottom of this portion of the main window.

Bear in mind that the Sub-area Entry and Summary portion of the WinTR-55 Main Window
contains information ONLY about the watershed sub-areas. Stream reaches and structures are 
treated separately, and other than to tell the program that runoff enters a particular stream 
reach or structure, no further information is given about stream reaches or structures.
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Modeling Single Sub-Area Watersheds

Output Definition Window

• Open by clicking the 
Summary Reports 
Button

• Select Reports

• Certain reports may be 
grayed out

You have the option of specifying the type of output you would like to view upon 
successful completion of a run.  You may, at anytime open the Output Definition
window to specify available reports. However, available reports are dependent upon 
the data entered, whether or not a run has been executed, and the type of analysis 
being made. Until certain reports are available, some of the listed items will be grayed 
out.

You may specify whether to send the requested reports directly to a printer or file 
by selecting Printer/File; or to view the reports on the computer monitor by selecting 
the Report Viewer.

As shown, there are a wide array of reports available. Rather than go through and try 
to describe each report individually at this time, we’ll work through a demonstration 
problem and view some of the reports at that time.
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Run WinTR-55

• Run from main 
window menu bar 
or         button

• Run WinTR-55
window will pop up

• Check storm(s) to 
evaluate

• Click           button

Until you have entered sufficient data to execute a run, the Run menu option and Run 
button will remain grayed out.

Once sufficient data has been entered, the menu option and run button will go live 
and clicking Run from the menu bar or the Run button opens the Run WinTR-55 window.

On the Run WinTR-55 window you specify for which storm events you wish to 
execute runs. 

Clicking the Run button will cause the program to execute a run.
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Examining the Output

Upon successful completion of a run, the File Display window is opened to the 
Hydrograph Peak/Peak Time Table.

This, of course is only one of the many output reports that can be viewed.

The option exists of looking at several WinTR-20 Reports.

You may also access all available WinTR-55 Reports from this window even though 
none may have been specified on the Output Definition Window.
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Output Graphics Window
• From WinTR-55 Main Window 

click              button

• Select Segment Type

• Select Sub-area(s)
Reach(es) – specify up or downstream 
reach hydrograph if Reaches are 
specified

• Select Storm(s)

• Select Alternatives

• Click                 button to view 
hydrographs

Plotting and viewing hydrographs is done through the Output Graphics window, 
accessible through the Hydrographs button from the WinTR-55 Main Window.

From the Output Graphics window specify the segment type,

sub-areas or reaches,

selected storms, and

selected alternatives for which you wish to view the hydrographs.

If you select reaches as the segment type, you will also need to specify whether 
you want to view upstream or downstream reach hydrographs.

Once your selections are completed, click the Plot button to view the 
hydrographs.

We have not discussed all these terms yet, so don’t worry if you’re feeling a bit 
confused. We will discuss what all these things mean as we progress through the 
training.
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Graphics Window
• Options for Line 

Attributes

• Options for Grid 
Lines

• Print to Printer

• Save as bitmap 
image

There are several options within the Graphics window for customizing the appearance 
of the plotted hydrographs. You may also print the plot and save the plot as a bitmap 
image.


